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This manual should be used as a guide along with the 
screen specific help, printed Microsoft manuals and on-line 
help available through CustomerSource, along with 
assistance from your Microsoft Great Plains consultant, if 
needed. 
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TTaabbllee  ooff  CCoonntteennttss              PPaaggee  ##  

  

General Ledger             4 

 

Inventory             13 

 

Receivables Management         18 

 

Payables Management          20 

 

Fixed Assets Management         24 

 

Payroll              27 

 

 

 

 
NOTE: Although it is not required that all other users are out of Great 
Plains during the Year End close procedure, we recommend that no 

transactions be created during the process. If a situation arises 
during the procedure that would necessitate that the back up be 

restored, any work done in the interim will be lost. 
 

It is possible to have a fiscal year end that does not coincide with 
the end of the calendar year. When this is the case, it is necessary to 

close the Payroll module (if applicable) at the end of the calendar 

year and the remainder of the modules at the fiscal year end. The 
instructions contained herein assume that the fiscal year end is also 

the calendar year end. 
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YYeeaarr  EEnndd  CClloossiinngg  PPrroocceedduurreess  

 
 

**If you use more than the General Ledger module it is necessary to close all 

subsidiary modules prior to closing the General Ledger module.  If you only use 

the General Ledger module please skip Step 1. ** 

 

1. Complete the posting procedures and the closing procedures for all subsidiary 

modules 

a. Post final transactions in all the modules except the General Ledger 

b. Complete the month-end procedure and the quarter-end procedure for all the 

modules except the General Ledger 

c. Complete the year-end closing procedures for each module in the following 

order: 

I. Inventory (see pages 13-17 for detailed instructions) 

II. Receivables Management (see pages 18-19 for detailed 

instructions) 

III. Payables Management (see pages 20-23 for detailed instructions) 

IV. Fixed Asset Management (see pages 24-26 for detailed 

instructions) 

V. Payroll (see pages 27-33 for detailed instructions) 

Note Year-end procedures for the Payroll module are independent 

of the procedures in other modules. These procedures are 

always performed at the end of the calendar year regardless of 

your fiscal year. 

 

2. Post the final adjusting entries in the General Ledger module.  Adjusting entries 

include all entries that correct errors that were made when transactions were 

recorded. Adjusting entries also include journal entries that are used to assign 

revenues or expenses to the period that the revenues were earned in or that the 

expenses were incurred in. 

 

If you must make any adjusting entries to allocate revenue, expenses, or 

depreciation to the year that you are closing, use the Transaction Entry window or 

the Quick Journal Entry window to make adjusting entries in the General Ledger 

module. 

 

NOTE: It is not necessary to wait until you receive your audit adjustments from your 

CPA to perform the year end close procedures. The system allows you to post journal 

entries to the most recently closed fiscal year. Therefore, when you are at a point 

where you would print reports for your auditor, you are ready to perform year end 

closing procedures. The system will do a “mini year end close” when you post 

adjusting journal entries to a prior period. 

 

3. Print an account list to verify the posting type of each account 

 

The posting type determines whether an account is closed to the retained earnings 

account or whether an account brings a balance forward to the next fiscal year. If 

the account balance is going to be brought forward at the end of the year, the 

posting type must be set to Balance Sheet. If the account balance is going to be 



  

Year End Close Procedures  - 5 - 

closed to a retained earnings account at the end of the year, the posting type must 

be set to Profit and Loss. Use the Account Maintenance window if you must change 

the posting type for an account. NOTE: Unit accounts act as if they are Balance 

Sheet accounts and their balance will be brought forward. 

 

Follow these steps to print an account list:  

a. Open Smart List and click Accounts.  

b. The optimal columns to show are Account #, Account Description, Posting 

Type, Account Category Number and Active. 

c. Click on the excel icon near the top of the Smart List window and export 

the accounts.  

d. Note In Great Plains 8.0 and later, you can deactivate accounts that have 

a balance. These accounts are still processed during the year-end closing 

routine according to their posting type.  

 

4. Close the last period of the fiscal year. 

 

This step is optional. 

 

You can use the Fiscal Periods Setup window to close any fiscal periods that are 

still open for the year (Administration>>Setup>>Company>>Fiscal Periods). This 

prevents transactions from being posted to the wrong period or year. 
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a. Make sure that you post all the transactions for the period and the year 

for all modules before you close the fiscal periods. Later, if you have to 

post transactions to a fiscal period that you already closed, you must 

return to the Fiscal Periods Setup window to reopen the period.  

b. If you use FRx Reporter, keep one period in the most recent 

historical year open to prevent the following error message:  

I. FRX Print Engine Failed to Load the Company Calendar. 

5. Perform File Maintenance on the Financial Series group of modules. 

(Microsoft Dynamics GP>>Maintenance>>Check Links)  
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6. Verify the settings in the General Ledger Setup window. 

(Microsoft Dynamics GP>>Tools >> Setup >> Financial >> General Ledger)  

 
 

If you want to keep historical records, you must click to select the Accounts check 

box and the Transactions check box in the Maintain History area of the General 

Ledger Setup window. The account history lets you print financial statements and 

calculated budgets from historical information. The transaction history lets you print 

detailed historical trial balances and allows you view transaction detail. Both the 

account history and the transaction history are updated during the year-end closing 

routine if these check boxes are selected. 

 
7. Make a backup.   

 

Make a backup of all company data, and put the data in safe permanent storage. The 

backup gives you a permanent record of the company's financial position at the end 

of the year. The backup can be restored later if it is required.  



  

Year End Close Procedures  - 8 - 

 

8. Print a final Detailed Trial Balance. 

 

Use the Trial Balance Report window to print a year-end Detailed Trial Balance. 

 
You can print a hard copy or, if you own Adobe Writer (not Reader) you can print to 

the screen and then click the Send To button to send yourself a PDF file which you 

can save on your computer or you can do both. 

 
Note: We recommend that you post all transactions for the period and the year for 

all modules before you print the Detailed Trial Balance. If you post additional 

transactions later, we recommend that you print a new Detailed Trial Balance. 
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9. Print year-end financial statements. The majority of clients use FRx. 

 

Print any year-end financial statements that are required by your organization. The 

most common financial statements include the following:  

a) Balance Sheet  

b) Profit and Loss Statement  

c) Statement of Cash Flows  

 

10.  Set up a new fiscal year (if not already done). 

 

Before you can perform the year-end closing routine, you must set up a new 

fiscal year by using the Fiscal Periods Setup window (Microsoft Dynamics GP 

>>Tools>>Set up>> Company>>Fiscal Periods).  

 

In many cases, when you are in the 12th month of your fiscal year you may have 

the need to post transactions in month one of the next fiscal year. You can set 

up future fiscal years at any point in time, however we recommend that you 

keep the period closed in future fiscal years until you are ready to use them 
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11. Close the fiscal year.  

 

To close the fiscal year, follow these steps:  

a. Click Microsoft Dynamics GP>>Tools>>Routines>>Financial>>Year-End 

Closing. 

 

b. Specify an account in the Retained Earnings Account field (if not already 

done so for a previous fiscal year). 

 

The account that you specify in the Retained Earnings Account field is the 

account that the year's profit or loss is closed to. The default account is 

the account that you specified in the General Ledger Setup window.  

 

All current-year earnings or losses are transferred to the account that you 

specify here. If you want to distribute the retained earnings for the year 

to more than one account, you can specify an allocation account to 

distribute the retained earnings amount to the appropriate accounts. For 

example, you could set up an allocation account to divide the earnings 

between several departments in your business. 

 

Or, you could transfer the year's profit or loss to accounts that contain a 

specific account segment. This is referred to as closing to a divisional 

retained earnings account. Contact one of our consultants for specifics of 

this procedure. 

c. Specify the number that you want to use as the first journal entry number 

for the next fiscal year in the Starting Journal Entry field or you can just 

follow with the next number in sequence. 

 

You can accept the default number. The default number is one more than 

the highest journal entry number that is posted for the current year. Or, 
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you can specify a new number. The journal entry number that you specify 

is used as the journal entry number for the Year-End Closing Report.  

d. Click Close Year to start the routine. 

 

Important: Click Close Year one time. If you click more than one 

time, you will close more than one year during the process. Also, if the 

progress window appears to stop at 50 percent, do not restart the 

routine. As long as the hard disk is processing, let the process continue. 

e. If you are maintaining account history, the year-end closing routine 

transfers all current-year information for each account in the chart of 

accounts to account history. If you are maintaining transaction history, the 

year-end closing routine also transfers all current-year information for each 

account in the chart of accounts to transaction history. The process then 

prepares the accounting system for a new fiscal year. Besides transferring 

current-year figures to transaction history and to account history, the year-

end closing routine does the following:  

f. The year-end closing routine reconciles and summarizes the general 

ledger balances that accumulated throughout the year.  

g. The year-end closing routine removes accounts that are marked as 

inactive if the accounts match the criteria for deleting a posting account.  

h. The year-end closing routine moves all profit and loss account balances to 

the retained earnings account (the account specified in Step 11b).  

i. The year-end closing routine summarizes balance sheet accounts and 

brings the balances forward as the beginning balances of the account in 

the new fiscal year.  

j. The year-end closing routine prints the Year-End Closing Report. 

k. When the year-end closing routine is complete, the Year-End Closing Report 

is printed. This report lists the accounts that were closed and the 

transactions that were created to close those accounts. The Year-End 

Closing Report is part of the audit trail. Save this report for your company's 

permanent records. The Year-End Closing Report cannot be reprinted. 
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12. Load budget figures for the new year and print financial statements. 

 

Load budget figures by using one of the following windows:  

a) Excel-Based Budgeting  

b) Budget Maintenance  

c) Single-Account Budget Maintenance 

d) Print the Profit and Loss Statement for the next fiscal year to verify that profit 

and loss accounts were closed to the retained earnings account. Print the 

Balance Sheet to verify that balance sheet accounts indicate that the balances 

were brought forward. 

 

13. Make another backup. 

Make a backup of all company data, label it accordingly and put it in safe 

permanent storage. The backup gives you a permanent record of the company's 

financial position at the beginning of the new year. This backup can be restored 

later if it is required. 
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Year End Closing - Inventory 

 
NOTE: If you are using the perpetual inventory method you do not 

need to run Inventory year end unless you would like to have your 
discontinued items purged. 

 
1. Post all transactions for the year. 

Be sure that all Invoicing, Sales Order Processing and Inventory transactions for the 

current year have been entered and posted before you close the year. This is 

important to ensure that historical information is accurate for the year you’re closing 

and year-to-date amounts are accurately stated for the new year. If you wish to 

enter future-period transactions before closing the year, create a new batch with 

new transactions, but don’t post it until after the year has been closed.  

 

2. Reconcile Inventory Quantities. 

Reconcile Quantities for all Inventory Items using the Reconcile Inventory Quantities 

window (Microsoft Dynamics GP>>Tools>>Utilities>>Inventory>>Reconcile)  

 
This process ensures that your Inventory Control data hasn’t become damaged over 

the course of the year. If any discrepancies are found during the Reconcile process, 

the Quantities will be adjusted. If adjustments are made, they’ll be reflected on the 

Reconcile Report, along with any Serial Numbers and Lot Numbers that were added 

for the adjusted Items. If you want to edit these Serial and Lot Numbers, you can 

use the Item Transaction Entry window (Inventory>>Transactions>>Transaction 

Entry) to do so by making adjustment transactions.  
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3. Complete a Physical Inventory count and post any adjustments.  

a) Use the Stock Calendar Maintenance window (Microsoft Dynamics 

GP>>Tools>>Setup>>Inventory>>Stock Calendar)  

 
to set up and maintain information about when stock counts can be 

performed, and which days will be “counted” when the system calculates 

suggested dates for the next stock count for a specific item-site combination.  

 

The Stock Count Count Cycle Assignment window (Inventory 

>>Cards>>Count Cycle Assign) can be used, if desired, to assign one stock 

count frequency to many items.  

b) Create a Stock Count Schedule (Inventory>>Transactions>>Stock Count 

Schedule) — a list of the specific items at a specific site that will be counted 

during a specific count. When you start a stock count schedule, the quantity 

on hand for each line in the stock count schedule is captured. Later, the 

actual count number quantities will be compared to the captured values to 

create default variance transactions. Stock Count Forms can be printed during 

this process.  

c) Use the Stock Count Entry (Inventory>>Transactions>>Stock Count Entry) 

window to enter information about the results of your stock counts. When you 

process a stock count, variance transactions are created. If the Autopost 

Stock Count Variances option is marked, the transactions also will be posted. 
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Instead of going through the Stock Count procedure listed above, you could 

manually create your adjusting entries. Print a Physical Inventory Checklist using the 

Inventory Activity Reports window (Inventory>>Reports>>Activity)  

  

and perform a physical count of your Inventory Items to verify that Quantity on 

Hand amounts are accurate for all Items. If discrepancies exist, enter the necessary 

adjustments in the Item Transaction Entry window (Inventory>> 

Transactions>>Transaction Entry) and post them.  

 

4. Print additional reports. 

Print any additional reports you’ll need for planning or your permanent records, 

including the Stock Status Report, Purchase Receipts Report, Turnover Report, 

Transaction History Report, Serial Number List, and Lot Number List. Use selections 

from the Inventory Reports palette (Inventory>>Reports) to print these reports. If 

you plan to remove sold Purchase Receipts during the year-end closing process, we 

recommend that you print the Purchase Receipts Report to review the receipts that 

will be removed.  

 

5. Make a backup. 

Make a backup of all Company data. This is important to ensure that you’ll be able to 

recover quickly should a power fluctuation or other problem occur during the year-

end closing procedure.  

 

6. Close the year. 

Closing a year accomplishes the following tasks:  

a) Transfers all summarized current-year Quantity, Cost and Sales amounts to 

transaction history for the Items for which you’ve been keeping summarized 

Sales History.  

b) Updates the Item’s Beginning Quantity to the Quantity on Hand at each Site. 

Certain reports, such as the Turnover Report, use the Beginning Quantity field 

for report calculations.  
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c) Zeros the Quantity Sold field in Item Quantities Maintenance (Cards - 

Inventory - Item - Qtys/Sites) for each Site.  

d) Remove Purchase Receipts for Items that have been completely sold.  

e) Remove any discontinued Items from the Item records that have been 

completely sold.  

f) Remove any Lot attributes from the records of Lot Numbered Items if they’ve 

been completely sold.  

g) Updates the Standard Cost of each Item to the current Cost if you’re using 

either the FIFO periodic or LIFO periodic Valuation Method.  

h) Use the Inventory Year-End Closing (Inventory>>Routines>> Year-End 

Close) to close the year.  

 
Use the following descriptions to learn more about each option:  

 Remove: Discontinued Items - If you mark the Discontinued Items option, all 

discontinued Items that have a zero balance will be removed during the year-end 

closing process. (Items can be designated as discontinued using the Item 

Maintenance window.) Discontinued Items that have a Quantity On Hand of zero 

(except for kit components) and do not have any unposted transactions will be 

completely removed from the Inventory module. Note - If using the Service 

module, verify whether any discontinued Items exist on any unposted service 

documents. If so, the documents must be posted before proceeding. The Sales 

Order Processing, Invoicing, or Purchase Order Processing reports and inquiries 

will still be able to pull information regarding these discontinued Items, however 

you will not be able to do a lookup on the Item Number since it has been 

removed from the Item Master. If you would like to print a report or inquire on 

the discontinued Item, you will need to include the Item within the Item Number 

Range.  

 Remove: Sold Receipts - If you mark Sold Receipts, all Sold Receipts whose 

Quantity Received and Quantity Sold amounts are equal will be removed. This is 

an optional step and may not be a procedure that is done every year-end. These 

values may be helpful when Items are returned through Invoicing so you may not 

want to remove the Receipts from the file.  

 Remove: Sold Lot Attributes - If you mark Sold Lot Attributes, values for 

completely sold Lot Numbers will be removed. For example, you can remove 

the value red for the Lot attribute color if you’ve sold all Lot Numbered Items 

that have been assigned the value red.  

 Update: Item’s Standard Cost - If you mark Item’s Standard Cost, the 

Standard Cost for any Items that have been assigned the FIFO periodic or 

LIFO periodic Valuation Method will be adjusted automatically to reflect each 

Item’s current Cost or the amount you most recently paid for the Item.  
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When you’ve selected all the options you want, choose OK to begin the year-end 

closing process. While the year is being closed, you won’t be able to post, 

reconcile Quantities, change Valuation Methods or change Decimal Places 

for Items.  

7. Close the fiscal periods for the Inventory series (optional). 

You can use the Fiscal Periods Setup window (Microsoft Dynamics 

GP>>Tools>>Setup>>Company>>Fiscal Periods) to close any fiscal periods that are 

still open for the year. This keeps transactions from accidentally being posted to the 

wrong period or year. Be sure you’ve posted all transactions for the period and year 

for all modules before closing fiscal periods. If you later need to post transactions to 

a fiscal period you’ve already closed, you’ll need to return to the Fiscal Periods Setup 

window to reopen the period before you can post the transaction.  

 

8. Make a final backup. 

Make a final backup of your Company’s data files and keep it in safe, permanent 

storage. This gives you a permanent record of the Company’s financial position at 

the time you closed the year, and can be restored later if necessary. 

Inventory Year-End Closing Tips 

The year-end close must be done before any transactions for the new year have been 

posted.  

You have the option of marking Discontinued Items, Sold Receipts or Sold Lot Attributes. If 

marked, all Items, Sold Receipts or Sold Lot Attributes that have a zero balance will be 

remove during the year-end closing process.  

If you mark Update Item’s Standard Cost, the Standard Cost for any Items that have been 

assigned the FIFO periodic or LIFO periodic Valuation Method will be adjusted automatically 

to reflect each Item’s current Cost, which is the amount you most recently paid for the 

Item.  

There is no Year End Closing report for Inventory. 

Inventory Year-End Questions and Answers 

Q1: How is the Average Cost of an Item updated throughout the year and during the year-

end closing process when using the Average Perpetual Method of Costing? 

A1: If you’re using the Average Perpetual Costing Method, all Receipts for each Item will be 

averaged to determine the Average Cost. Even if Quantities are sold, the Average doesn’t 

change until another Purchase Receipt for the Item is posted to the Inventory Purchase 

Receipts File. The year-end closing process doesn’t change the Average Cost, but it will 

remove the Purchase Receipts that have been completely sold. The next time a Receipt is 

entered, the Average Cost will be revalued with the Receipts that remain in the Inventory 

Purchase Receipts File.  

 

Q2: Can the Inventory Year-End Closing window (Inventory >>Routines>>Year-End Close) 

be used throughout the year to update the standard Cost of Items if using the Periodic 

Valuation Method? 

A2: This is not recommended because the Beginning Quantity field is updated during the 

year-end closing process. This would make that field incorrect on reports such as the 

Turnover Report. 
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YYeeaarr  EEnndd  CClloossiinngg  PPrroocceedduurreess  ––  RReecceeiivvaabblleess  MMaannaaggeemmeenntt  
  

1. Post all transactions for the year. 

 

2. Make a backup. 

Make a backup copy of your company data so that you will be able to recover quickly 

if a power fluctuation or other problem occurs during the year-end closing procedure. 

 

3. Close the calendar year. 

 In the Receivables Year-End Closing window, click to select the year that you 

want to close (Sales>>Routines>>Year-End Close). If the calendar year 

coincides with your fiscal year, click to select All.  If the calendar year does not 

coincide with your fiscal year, close the fiscal year and the calendar year 

separately. 

 Click to select the Print Report box.  This report lists the amounts that were 

transferred to last-year fields for each customer. 

 The Year-End Closing report will print.  It is part of the audit trail, and you 

should save it with your company’s permanent records. 

 

4. Close the fiscal periods for the Sales series (optional). 

 You can use the Fiscal Periods Setup window to close any fiscal periods that 

are still open for the year (Microsoft Dynamics GP >>Tools>>Set up>> 

Company>>Fiscal Periods).  Closing the fiscal periods that are still open for the 

year prevents transactions from accidentally being posted to the wrong period or 

to the wrong year. 

 Make sure that you have posted all transactions for all modules for both the 

period and the year before you close fiscal periods. 

 If you later have to post transactions to a fiscal period that you have already 

closed, you will have to return to the Fiscal Periods Setup window to reopen 

the period before you can post the transaction. 

5. Close the sales tax periods for the year (optional). 

 Use the Tax Year-End Closing window to close the sales tax periods and to 

print the Tax Year End Closing report. 

(Administration>>Routines>>Company>>Tax Year-End Close). 

 Complete this procedure only after you have completed the year-end 

closing procedures for all Sales and Purchasing modules. 

 

6. Make a final backup.  

Make a final backup of your Company’s data files and keep it in safe, permanent 

storage. This gives you a permanent record of the Company’s financial position at 

the time you closed the year, and can be restored later if necessary. 

 

 

Receivables Management Year End Closing Tips 

 

Closing the calendar year will clear the calendar year-to-date finance charges and will move 

them to the Last Year field in the customer records. 

 

The calendar year-end close in Receivables will occur at the end of the calendar year, 

regardless of when your fiscal year ends.  If your calendar year coincides with the fiscal 

year, you will close both of them at the end of the calendar year. 
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 The YTD finance charges do not automatically print on the statements in December 

and January.  If you want them to print on the statements check with one of the 

consultants for assistance on modifying the necessary report(s). 

 

Closing the fiscal year will transfer all amounts other than the calendar year-to-date finance 

charge amounts to last year. 
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YYeeaarr--EEnndd  CClloossiinngg  ––  PPaayyaabblleess  MMaannaaggeemmeenntt  

 

1. Post all transactions for the calendar year. 

Post all transactions for the calendar year BEFORE you close the year.  

 

2. Print the Aged Trial Balance with Options Report. 

(Purchasing>>Reports>>Trial Balance - Aged Trial Balance w/Options) to show the 

status of each Vendor Account. This report should be kept with your permanent 

records as part of the audit trail. 

 

If you are closing the fiscal year together with the calendar year, we recommend 

that you print the Vendor Period Analysis Report (Purchasing>> 

Reports>>Analysis>>Period) and the Vendor Year-to-Date Summary reports 

(Purchasing>>Reports>>Analysis>>Calendar Year) for your permanent records 

because these amounts will be transferred to last year during the year-end closing 

process. 

 

3. Make a backup. 

Make a backup of all Company data and put it in a permanent storage. This gives 

you a permanent record of the Company’s financial position at the end of the year 

and can be restored later. 

 

4. Verify the 1099 information is correct by printing the 1099 Edit List. 

(Purchasing>>Routines>>Print 1099s). 
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5. To print the edit list from the Print 1099 window, click Print on the File menu. You 

can also print the 1099 Edit List if you click the printer icon from the Print 1099 

window. 

 

The 1099 Amount information is updated automatically when a 1099 invoice is fully 

paid. The 1099 information can be edited for each vendor using the 1099 Details 

(Purchasing>>Cards>>1099 Details). 

 

 

5. Print 1099 statements using the Print 1099 window.  

This step can be completed at any time. You will be able to select the year you want 

to print the 1099s for. 

 

6. Close the calendar year. 

(Purchasing>> Routines>>Year-End Close)  

Close the calendar year using the Payables Year-End Closing window. Select whether 

you want to close the fiscal year, calendar year, or All to close both years. If the 

calendar year coincides with your fiscal year, select All. If they do not coincide, close 

the fiscal year separately.  

 
Mark the Print Report option to print the Payables Year-End Closing report after the 

closing process is completed. This report lists the amounts transferred to Last Year 

Summary amounts for each vendor. The report will print the amounts from the date 

of the current close to the prior year close. The amounts may be different from what 

appears when you click Cards, click Purchasing, click Summary, and then click Yearly 

 

The Year-End Closing Report is part of the audit trail and should be saved with your 

Company’s permanent records. 

 

7. Close the fiscal periods for the Payables series (optional). 

You can use the Fiscal Periods Setup window to close any fiscal periods that are still 

open for the year (Microsoft Dynamics GP >>Tools>>Set up>> Company>>Fiscal 

Periods).This keeps transactions from accidentally being posted to the wrong period 

or year. Make sure you have posted all transactions for the period and year for all 

modules before you close fiscal periods. 
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If you must post transactions to a fiscal period you have already closed, you must 

return to the Fiscal Periods Setup window to reopen the period before you can post 

the transactions. 

 

8. Close the sales tax periods for the year (optional) 

Close the sales tax periods and print the Tax Year-End Closing Report for the year 

using the Tax Year-End Closing window. This step is optional.  

Note : This procedure should only be completed after you have completed 

the year-end closing procedures for all sales and purchasing modules. 

 

9. Make a final backup. 

Make a final backup of your Company’s data files and keep it in safe, permanent 

storage. This gives you a permanent record of the Company’s financial position at 

the time you closed the year, and can be restored later if necessary. 

 

Payables Management Year-End Closing Tips 

Print the 1099 statements using the Print 1099 window. 

 

The 1099 Amount YTD information is updated automatically when a 1099 Invoice is paid. 

The 1099 YTD information can be edited for each Vendor using the Vendor Period 

Summary window (click Cards, click Purchasing, click Summary, and then click Period). 

This would be needed if a 1099 invoice was entered, but a 1099 amount was not entered.  

 

Currently, Great Plains does not handle magnetic media filing of state 1099s. If you are 

interested in a solution that offers this functionality, please contact BCG Systems, Inc. and 

we will discuss options that offer compatible State W-2 and 1099 magnetic media products. 

 
BCG Systems, Inc. 

1735 Merriman Rd. 

Akron, OH  44313 

E) info@bcgsystems.com 

P) (800) 968-6661 

www.BCGSystems.com 

 

Payables Management Year-End FAQ  

Q: Are inactive Vendor records cleared during year-end closing? If not, how can inactive 

Vendor records be removed?  

 

A: No, inactive Vendor records are not automatically removed. To remove an inactive 

Vendor record, the record must not have a current year 1099 amount or documents in 

history (the work and open files have to be empty for this Vendor to be inactive). When the 

records have been removed from history, a Vendor or Vendors can be deleted using the 

Vendor Maintenance window or the Mass Vendor Delete window. 

 

Q: What exactly do the Payables Management Year-End Close procedures do?  

 

A: The Calendar Year-End Close moves the 1099 Amount YTD into 1099 Last Year in the 

Vendor Yearly Summary Amounts Since Last Close view. The Fiscal Year-End Close moves 

all other YTD amounts into Last Year amounts.  

 

mailto:info@bcgsystems.com
http://www.bcgsystems.com/
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Q: What should I do if I must issue a check on January 2, 2010, but am not ready to close 

2009 

 yet? 

 

A: Run the calendar and fiscal year-end close for Payables. If you use SmartList or the 

Vendor Summary report, you can manually update the Amounts Since Last Close view for 

any additional 2010 activity entered after the close. The 1099 information will be correct. 

 

Q: Is there a way to print an edit list of the 1099 Vendors before I actually print the 1099 

statements?  

 

A: A 1099 report can be printed using the Print 1099 window. When the Print 1099 

window is open, click Print on the File menu. An edit list that contains the Vendor ID, 

Vendor Name, Address, and 1099 amount will be printed. You can also print the edit list if 

you click the printer icon in the Print 1099 window.  

 

Q: I have printed 1099 statements and some the statements did not have the Vendor Name 

appearing on them. What should I do? 

 

A: When you print 1099 statements, the Check Name entered for the Vendor record in the 

Vendor Maintenance window will appear on the statement. If there is no Vendor Name 

appearing on the statement, the Check Name field in this window is blank. Enter a Check 

Name for each Vendor or use Report Writer to change the report to use a different field. For 

more information about modifying a report, see the Report Writer manual. 
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YYeeaarr  EEnndd  CClloossiinngg  ––  FFiixxeedd  AAsssseettss  
  

 

1. Ensure all Payables transactions relating to FA have been posted. 

This will ensure all transactions are capitalized in Fixed Assets.  

 

2. Post all transactions for the year. 

Enter in all activity for the current fiscal year. This includes additions, changes, transfers 

and retirements. Note: Transfers and Undo Retirements should never be performed 

in a historical year.  

 

3. Run depreciation. 

Run depreciation on all assets through the last day of the current fiscal year. Microsoft 

Dynamics GP – Tools – Routines – Fixed Assets - Depreciate. 

 

4. Process the GL Interface (GL Posting) routine.  

Microsoft Dynamics GP - Tools - Routines - Fixed Assets - GL Posting 

 

5. Print Reports 

Run reports, specifically reports which include year-to-date depreciation amounts as that 

information is not saved for previous/closed fiscal years in Fixed Assets. Some suggested 

reports that are normally run at year-end are:  

 

-Annual Activity  

-Additions  

-Retirements  

-Transfers  

-Depreciation Ledger  

-Property Ledger  

-Fixed Assets to General Ledger Reconciliation  

 

The Book to Book Reconciliation and Book to Book YTD Depreciation Comparison reports are 

also available for comparing any two fixed assets books. There are over 25 standard reports 

that may be run. You may elect to print these reports to a file as well so you can choose to 

print them again in the future, if needed.  

 

6. Verify that the Quarters are set up correctly for all fiscal years.  

 

Microsoft Dynamics GP - Tools - Setup - Fixed Assets - Quarters 

 

7. Make a backup. 

Make a permanent backup of all the fixed assets files to ensure that you can run additional 

reports later, if necessary. This should be a backup that is archived off-site and is never 

erased.  

 

8. Perform the Fixed Asset Year-End Close routine.  

 

Performing Year End Close:  

Microsoft Dynamics GP - Tools - Routines - Fixed Assets - Year End 
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A. Verify that the Current Fiscal Year on the Available Books list is correct.  

 

B. Select each book to be closed by highlighting the book in the Available Books list and 

clicking Insert. The year-end process will be performed for each book in the Selected Books 

list.  

 

C. Click the Continue Button. The year-end process will begin. A report is not generated 

from this process.  

 

D. Verify that year-end completed successfully by using reports and inquiries to verify the 

items in the Functions Performed during Year End Routine section of this document.  

 

Fixed Assets Year-End Closing Tips and Notes 

 

Because Fixed Assets is not a date sensitive module, we recommend ensuring all 

transactions coming from Payables have been capitalized in the Fixed Assets system.  

 

The year-end routine can be run at a separate time for each fixed asset book or it can be 

run for all books at the same time. However, this routine must be completed before running 

any fixed assets processing for the new year. 

 

Functions Performed During the Year End Routine: 

 In the Asset General Information window:  

-The YTD Maintenance amount is removed  

-The Quantity is copied to the Begin Quantity field  

 In the Asset Book window:  

-The YTD Depreciation Amount is removed  

-The following fields are copied:  

Cost Basis to Begin Year Cost  

Life to Date Depreciation to Begin Reserve  

Salvage to Begin Salvage  

 Increases the current fiscal year by one year for each book that is being closed. 

 

 

 

Fixed Assets Year-End FAQ:  

1. I have closed the General Ledger module and realized that I haven’t closed the Fixed 

Assets module yet. Can I perform the Fixed Assets Year-End close process at this point?  

 

We recommend closing the General Ledger module last (after all of the subsidiary modules 

have been closed.) However, Fixed Assets can be closed after the General Ledger Year-End 

Close. The GL Interface process can be performed and the transaction(s) posted to the 

closed/historical year in the General Ledger. To post to the historical year in General 

Ledger, make sure that the following options are marked in the General Ledger Setup 

window under Setup - Financial - General Ledger (Microsoft Dynamics GP - Tools - Setup - 

Financial - General Ledger):  

-Allow Posting to History  

-Maintain History Accounts  

-Maintain History Transactions  

 

The posted transaction will update the historical year and roll forward as a beginning 
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balance to the open year. If any expense or revenue accounts were included in the 

transaction, they will automatically close out to the Retained Earnings account(s).  

 

2. I processed the Fixed Assets Year-End routine and have run depreciation in the new year. 

I noticed that the depreciation is highly overstated and some of my assets have a negative 

Net Book Value. Why is the system calculating so much depreciation?  

 

This will happen if the year was closed and the assets were not depreciated through the 

very last day of the fiscal year. For example, if the fiscal year is a calendar year (January 1 

– December 31) and the assets were depreciated through December 28th when the year 

was closed, depreciation will be incorrect the next time it is run. The system does not 

recalculate the yearly rate when the year-end routine is performed; therefore, it will take a 

full year’s worth of depreciation (the yearly rate currently on each asset) in the last few 

days remaining in the previous year (December 29th – December 31st). If there are assets 

near the end of their original life, it can cause the Net Book Value to go negative as well.  

 

There are a couple of solutions available if this situation is encountered. The first 

(recommended) solution would be to restore the data from a backup, run depreciation 

through the very last day of the year, and perform the year-end procedure. The other 

solution would be to reset life on all of the assets. However, if amounts have ever been 

plugged for YTD and LTD Depreciation on the assets, resetting the life would change those 

amounts and the end result may be different. This will cause inconsistencies between the 

Fixed Asset module and the General Ledger which would need to be accounted for.  

 

3. Instead of going through the year-end routine for Fixed Assets, I manually changed the 

Current Fiscal Year field in the Book Setup window to the next year. Do I need to go back 

and run the year-end routine or can I continue processing activity in Fixed Assets for the 

new year?  

 

If no activity (additions, changes, transfers, retirements, and/or depreciation) has been run 

for the new year, the Current Fiscal Year field in the Book Setup window can be changed 

back to the previous year and the year-end routine can be processed.  

 

If activity (additions, changes, transfers, retirements, and/or depreciation) has been run for 

the new year, restore the data from a backup and proceed with the year-end close routine.  

 

In either situation, the year-end routine needs to be run. If it isn’t, then the YTD 

Depreciation Amount will be overstated on any report that includes assets that were retired 

or fully depreciated in the previous year. When the year-end close is not performed, the 

YTD Depreciation amounts will not be removed (zeroed out) so they will be incorrectly 

included on the reports for the new year. 
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YYeeaarr  EEnndd  CClloossiinngg  PPrroocceedduurreess  ––  PPaayyrroollll  
 

 

Complete the steps in the following checklist to install Payroll maintenance changes and to 

close the 2009 Payroll year. In the final step of this checklist, you will install the 2009 

Payroll Tax Update.  

 

We recommend you install the latest service pack for your Microsoft Dynamics GP 

application before installing the 2009 Payroll Year-End Update. Please speak to a 

consultant if you have any questions, concerns, or need assistance with this, or 

any other, Year End procedure. Please note that the service pack will need to be 

installed first on the server and then on all client machines. 

 

Note The 2009 Payroll Year-End Update file and the 2010 Payroll Tax Update file will be 

available for Microsoft Dynamics GP 9.0 and 10.0. The 2009 Payroll Year-End Update 

file and the 2010 Payroll Tax Update file will not be compatible with Microsoft 

Business Solutions - Great Plains 8.0 or with earlier versions. 

 

Payroll year-end checklist 

To perform the year-end closing procedures, follow these steps:  

1. Verify that you have installed the latest 2009 payroll tax update 

2. Complete all pay runs for the current year 

3. Complete all month-end, period-end, or quarter-end procedures for the current year 

4. Make a backup of the original file 

5. Install the Year-End Update 

6. Create the Year-End file 

7. Make a backup of the new file 

8. Verify W-2 and 1099-R statement information 

9. Print the W-2 statements and the W-3 Transmittal form 

10. Print the 1099-R forms and the 1096 Transmittal form 

11. (Optional:) Create the W-2 Electronic file 
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12. (Optional:) Archive inactive employee Human Resources information 

13. Set up fiscal periods for 2010 

14. (Optional:) Close fiscal periods for the payroll series for 2009 

15. Install the payroll tax update for 2010 

 

Alternative payroll year-end checklist 
If you must process 2010 pay runs before you complete the year-end closing procedures, follow 

the steps in this alternative checklist:  

1. Verify that you have installed the latest 2009 payroll tax update 

2. Complete all pay runs for the current year 

3. (Optional:) Complete all month-end, period-end, or quarter-end procedures for the 

current year 

4. Make a backup of the original file 

5. Install the Year-End Update 

6. Create the year-end file 

7. Make a backup of the new file 

8. Verify W-2 and 1099-R statement information 

9. (Optional:) Archive inactive employee Human Resources information 

10. Set up Fiscal Periods for 2010 

11. (Optional:) Close the fiscal periods for the Payroll series for 2009 

12. Install the payroll tax update for 2010 

13. Process the 2010 pay runs. The user date must occur in 2010. 
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14. Print the W-2 statements and the W-3 Transmittal form 

15. Print the 1099-R forms and the 1096 Transmittal form 

16. (Optional:) Create the W-2 Electronic file 

 

Payroll module year-end details 

Verify that you have installed the latest 2009 tax update 

Download the latest tax table updates and installation instructions: 

 

Customers 

https://mbs.microsoft.com/customersource/support/downloads/taxupdates/ 

 

Complete all pay runs for the current year 

(Optional:) Complete all monthly and quarterly payroll month-end, period-end, or 

quarter-end procedures for the current year 

For more information about period-end procedures for payroll, view Chapter 21, "Payroll 

Company Routines," in the Microsoft Dynamics GP user's manual. You can find this user manual 

in Dynamics GP by clicking on the Help icon, click on Printable Manuals, click on Human 

Resources/Payroll and then click on Payroll (USA) with Direct Deposit.  

Make a backup of the original file 

Create a backup, and then put this backup into safe, permanent storage. By creating a backup, 

you make sure that you have a permanent record of the company's financial position at the end 

of the year. You can restore the backup to quickly recover data if a power fluctuation or other 

problem occurs during the year-end closing procedure. 

 

To create a backup in Microsoft Dynamics GP, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics GP 

menu, and then click Backup. In Microsoft Dynamics GP 9.0, click Backup on the File 

menu. 

 
Note The Back Up Company window opens. 

2. In the Company Name list, click your company name. 

3. 
Change the path of the backup file if it is required, and then click OK. 

 

Note We recommend that you name this backup 2009 Pre Year-End Update to 

differentiate it from your other backups. 

Install the year-end update 

 
To install the payroll year-end update, you must follow the steps in the Microsoft Dynamics GP 

U.S. 2009 Year-end document. IMPORTANT NOTE: The install must be performed on each 
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computer that has Microsoft Dynamics GP installed. 

 

When the update is released, install the update from the following location. 

 

Customers  

https://mbs.microsoft.com/customersource/support/downloads/taxupdates/ 

 

Note If you have employees with addresses outside of the U.S., the country codes table will 

need to be updated. Refer to the Microsoft Dynamics GP U.S. 2009 Year-End Update document 

for further details.  

Create the year-end file 

To create the year-end file, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamic GP menu, 

point to Routines, point to Payroll, and then click Year-End Closing. In Microsoft 

Dynamics GP 9.0, point to Routines on the Tools menu, point to Payroll, and then click 
Year-End Closing. 

2. 
In the Year field, type 2009, and then click Process. 

Note You can install the payroll tax update for 2010 any time after the year-end file for 2009 

has been created.  

Make a backup of the new file 

Create a backup, and then put this backup into safe, permanent storage. By creating a backup, 

you make sure that you have a permanent record of the company's financial position at the end 

of the year. You can restore the backup to quickly recover data if a power fluctuation or other 

problem occurs during the year-end closing procedure. 

 

To create a backup in Microsoft Dynamics GP, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics GP 

menu, and then click Backup. In Microsoft Dynamics GP 9.0, on the File menu, click 
Backup. The Back Up Company window opens. 

2. In the Company Name list, click your company name. 

3. 
Change the path of the backup file if it is required, and then click OK. 

Note We recommend that you name this backup 2009 Post Year-End File to 

differentiate it from your other backups. 

Verify W-2 and 1099-R statement information 

To view the W-2 information in Microsoft Dynamics GP 10.0, point to Tools on the Microsoft 

Dynamics GP menu, point to Routines, point to Payroll, and then click Edit W-2s. In 

Microsoft Dynamics GP 9.0, click Tools, point to Routines, point to Payroll, and then click Edit 

W-2s. 

 

To view the 1099-R information in Microsoft Dynamics GP 10.0, point to Tools on the Microsoft 

Dynamics GP menu, point to Routines, point to Payroll, and then click Edit 1099-Rs. In 

Microsoft Dynamics GP 9.0, click Tools, point to Routines, point to Payroll, and then click Edit 
1099-R. 
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Note If you change the W-2 or the 1099-R information, we recommend that you make another 

backup.  

Print the W-2 statements and the W-3 Transmittal form  

To print the W-2 statements, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Payroll, and then click Print W-2s. In Microsoft Dynamics 

GP 9.0, point to Routines on the Tools menu, point to Payroll, and then click Print W-
2s. 

2. In the Print W-2 Forms window, specify the following settings:  

• Print W-2s for: Normal Year-End 

• Print: W-2 Forms 
 

3. Click Print. 

Note You can print employee W-2 statements as many times as you have to. 

 

To print the W-3 Transmittal Form, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Payroll, and then click Print W-3s. In Microsoft Dynamics 

GP 9.0, point to Routines on the Tools menu, point to Payroll, and then click Print W-
3s. 

2. In the Print W-2 Forms window, specify the following settings:  

• Print W-2s for: Normal Year-End 

• Print: W-3 Transmittal Form 
 

3. Click Print. 

Note You can print the W-3 Transmittal Form as many times as you have to.  

Print the 1099-R forms and the 1096 Transmittal form 

To print the 1099 forms, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Payroll and then click Print 1099-Rs. In Microsoft 

Dynamics GP 9.0, point to Routines on the Tools menu, point to Payroll, and then click 

Print 1099-Rs. 

2. In the Print 1099-R Forms window, click 1099-R Forms, and then click Print. 

Note You can print employee 1099-R forms as many times as you have to. 

 

To print the 1096 Transmittal form, follow these steps:  
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1. In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Payroll, and then click Print 1099-Rs. In Microsoft 

Dynamics GP 9.0, point to Routines on the Tools menu, point to Payroll, and then click 
Print 1099-Rs. 

2. In the Print 1099-R Forms window, click 1096 Transmittal Form, and then click 

Print. 

Note You can print the 1096 Transmittal form as many times as you have to.  

(Optional:) Create a W-2 Electronic File 

To create a W-2 Electronic File, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Routines, point to Payroll, and then click W-2 Electronic File. In Microsoft 

Dynamics GP 9.0, point to Routines on the Tools menu, point to Payroll, and then click 

W-2 Electronic File. 

2. In the W-2 Electronic File window, click to select the check box that is next to each 

company that you want to include in your W-2 Electronic File. 

3. In the User ID Number field, enter the user ID number (formerly called a PIN). 

4. Click Submitter. The Electronic Filer Submitter Information window opens. Enter 

the submission information. 

5. Change the file destination information in the File Name field if it is required. 

6. Click Create File or Save to store the information to create the file later. 

(Optional): Archive inactive employee Human Resources information 

To archive inactive employee Human Resources information in Microsoft Dynamics GP 10.0, point 

to Tools on the Microsoft Dynamics GP menu, point to Utilities, point to Human Resources, 

and then click Archive Employee. In Microsoft Dynamics GP 9.0, click Tools, point to Utilities, 

point to Human Resources, and then click Archive Employee.  

Set up fiscal periods for 2010 

To set up fiscal periods for 2010, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Setup on the Microsoft Dynamics GP menu, 

point to Company, and then click Fiscal Periods. In Microsoft Dynamics GP 9.0, point 
to Setup on the Tools menu, point to Company, and then click Fiscal Periods. 

2. 
In the Year field, type 2010, and then click Calculate. 

Note You may want to close all periods except period 1 to prevent users from posting to 

future periods. 

3. Click OK. 
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(Optional:) Close fiscal periods for the payroll series for 2009 

You can use the Fiscal Periods Setup window to close all fiscal periods that are still open for 

the year. By closing fiscal periods, you prevent users from accidentally posting transactions to 

the wrong period or to the wrong year.  

 

Before you close a fiscal period, verify that you have posted all transactions for the period and 

for the year for all modules. To later post a transaction to a fiscal period that you have closed, 

you must first reopen the period in the Fiscal Periods Setup window. 

 

To close a fiscal period, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Tools on the Microsoft Dynamics GP menu, 

point to Setup, point to Company, and then click Fiscal Periods. In Microsoft 

Dynamics GP 9.0, point to Setup on the Tools menu, point to Company, and then click 
Fiscal Periods. 

2. Click to select the Payroll check box for each Period that you close. 

Install the payroll tax update for 2010 

Note Do not install the payroll tax update for 2010 until the year-end file has been created for 

2009. 

 

To install the payroll tax update for 2010, follow these steps:  

1. In Microsoft Dynamics GP 10.0, point to Maintenance on the Microsoft Dynamics GP 

menu, point to U.S. Payroll Updates, and then click Check for Tax Updates. In 

Microsoft Dynamics GP 9.0, point to Products and Services on the Help menu, and 
then click Check for Payroll Tax Updates. 

2. In the Tax Update Method window, click Automatic, and then click Next. 

3. In the Authorization Number field, type your authorization number, and then click Log 

in. 

4. Click Finish. 

 

Please contact BCG Systems, Inc. if you would like a recommendation for a solution that 

supports e-filing SUTA, Local Taxes, State and Federal W2s, 1099s, 401k, New Hire reports and 

more.  

 
BCG Systems, Inc. 

1735 Merriman Rd. 

Akron, OH  44313 

E) info@bcgsystems.com 

P) (800) 968-6661 

www.BCGSystems.com 
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